This document is one appendix from the book *Computation and Problem Solving in Undergraduate Physics (CPSUP)*. The first edition of *CPSUP* was registered with the Library of Congress with the call number QC20.C66.2004.

The second edition was registered with the Library of Congress with the LCCN 2019947884. It has been assigned the ISBN 9780961342968 and carries the Library of Congress call number QC20.C66.2019.
Preface

TGIF (pronounced T-G-I-F) is a versatile, publically available program for creating two-dimensional drawings. The program is Xlib-based and interactive, and it runs under X11 on LINUX and UNIX platforms (including MAC OS X and cygwin on Windows). The present document contains a printing of the TGIF appendix from the second edition of a much larger book titled *Computation and Problem Solving in Undergraduate Physics (CPSUP)*. It is published separately so that it can be available to provide a stand-alone quick introduction to TGIF for those who are interested in only that piece of software. This appendix provides only a start. Information (brief history, licensing understandings, instructions for downloading, . . .) about TGIF is available from the URL bourbon.usc.edu/tgif/.

The much larger work *CPSUP*, which has been under continuous development and refinement at Lawrence University since the mid 1980’s, was first published in 2003 with a second edition somewhat expanded from the first edition coming available in 2017.¹ *CPSUP* is a flexible, customizable text designed to

- support efforts to acquaint students with computational procedures and resources early enough so that they will be motivated and prepared to use these resources on their own initiative when circumstances warrant and so that later work need not be interrupted to deal with computational issues as an aside to its main purposes, and
- provide students with both the background and the confidence to support informed reading of vendor manuals, which usually do a splendid job of listing capabilities exhaustively but typically burden the beginner with initially irrelevant refinements and fail to illustrate adequately how even the rudimentary capabilities can be combined to perform useful tasks.

At Lawrence University, portions of *CPSUP* are used in a required sophomore course titled *Computational Mechanics* (CompMech) in which students develop an intermediate understanding of classical mechanics but also start the process of learning how to use available computational tools to pursue their studies in physics. The hope is that the materials treated in *CPSUP* and in CompMech will provide strong background so that instructors in subsequent courses can assign computational exercises and students can in subsequent courses have the confidence to exploit computational resources on their own initiative.

David M. Cook  
Appleton, Wisconsin  
23 December 2019

¹*CPSUP* is actually self-published, since its substantial customizability to include or exclude discussion of several computational tools—IDL, MATLAB, OCTAVE, PYTHON, MAXIMA, MAPLE, MATHEMATICA, FORTRAN, C, Numerical Recipes, \LaTeX\, TGIF, . . .—cannot even now be accommodated by commercial publishers. The article by David M. Cook titled “Computation in Undergraduate Physics: The Lawrence Approach” and appearing in the American Journal of Physics (Am. J. Phys. 76, 321–326 (April-May 2008)) describes these efforts in some detail. More information about *CPSUP* and the project that created it will remain for a time available at the website www.lawrence.edu/fast/cookd/cc11. Much of this information, however, is in the process of being moved to the Physical Sciences Resource Center of the AAPT ComPADRE Digital Library www.compadre.org/psrc, a library that is part of the National Science Digital Library.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td></td>
<td>iii</td>
</tr>
<tr>
<td>Table of Contents</td>
<td></td>
<td>v</td>
</tr>
<tr>
<td>B Introduction to TGIF</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>B.1</td>
<td>Beginning a TGIF Session</td>
<td>1</td>
</tr>
<tr>
<td>B.2</td>
<td>The Structure of the TGIF Window</td>
<td>1</td>
</tr>
<tr>
<td>B.3</td>
<td>A Tutorial Exploration of TGIF</td>
<td>3</td>
</tr>
<tr>
<td>B.4</td>
<td>Saving your Drawing</td>
<td>6</td>
</tr>
<tr>
<td>B.5</td>
<td>TGIF Options and Tools</td>
<td>7</td>
</tr>
<tr>
<td>B.5.1</td>
<td>Menu Options</td>
<td>7</td>
</tr>
<tr>
<td>B.5.1.1</td>
<td>MODE Menu</td>
<td>8</td>
</tr>
<tr>
<td>B.5.1.2</td>
<td>FILE Menu</td>
<td>11</td>
</tr>
<tr>
<td>B.5.1.3</td>
<td>EDIT Menu</td>
<td>13</td>
</tr>
<tr>
<td>B.5.1.4</td>
<td>LAYOUT Menu</td>
<td>14</td>
</tr>
<tr>
<td>B.5.1.5</td>
<td>ARRANGE Menu</td>
<td>14</td>
</tr>
<tr>
<td>B.5.1.6</td>
<td>PROPERTIES Menu</td>
<td>15</td>
</tr>
<tr>
<td>B.5.1.7</td>
<td>COLOR Menu</td>
<td>16</td>
</tr>
<tr>
<td>B.5.1.8</td>
<td>NAVIGATE Menu</td>
<td>16</td>
</tr>
<tr>
<td>B.5.1.9</td>
<td>SPECIAL Menu</td>
<td>16</td>
</tr>
<tr>
<td>B.5.1.10</td>
<td>HELP Menu</td>
<td>16</td>
</tr>
<tr>
<td>B.5.2</td>
<td>Panel Icon Options</td>
<td>17</td>
</tr>
<tr>
<td>B.6</td>
<td>Utilizing \LaTeX to Enter Equations in TGIF</td>
<td>17</td>
</tr>
<tr>
<td>B.7</td>
<td>Miscellaneous Additional Features</td>
<td>20</td>
</tr>
<tr>
<td>B.7.1</td>
<td>Keyboard Sequences</td>
<td>20</td>
</tr>
<tr>
<td>B.7.2</td>
<td>Creating Color PostScript Files</td>
<td>20</td>
</tr>
<tr>
<td>B.8</td>
<td>Default Values and Customizations</td>
<td>20</td>
</tr>
<tr>
<td>B.9</td>
<td>Exercises</td>
<td>21</td>
</tr>
<tr>
<td>Index</td>
<td></td>
<td>23</td>
</tr>
</tbody>
</table>
Appendix B

Introduction to TGIF

Developed while its author was a graduate student in the Department of Computer Science at the University of California–Los Angeles and now maintained by its author and made available from a website at the University of Southern California, TGIF\(^1\)—pronounced t-g-i-f as per the author’s instructions—is a wysiwyg\(^2\) interactive drawing tool that allows the user in an X-window environment running on a UNIX or Linux platform to create and manipulate a wide variety of two-dimensional drawings. Once the program has been launched, we select an appropriate succession of drawing modes from the Mode menu and assemble the desired drawing in the large Canvas window. The completed drawing can then be saved in any of several common graphics formats, including in particular PostScript and encapsulated PostScript. A full description of TGIF’s numerous capabilities will be found in the TGIF man-page.\(^3\) This appendix summarizes the most important and most useful of TGIF’s features and leads you through the creation and saving of a simple display. The discussion is structured as a tutorial and assumes that you are reading it while seated at a workstation running TGIF.

B.1 Beginning a TGIF Session

Detailed instructions for initiating a session with TGIF will be found in the Local Guide. In most cases, TGIF will be started by typing the command `tgif` at the prompt from the operating system. Presently the `Tgif` window will appear on the workstation screen.

B.2 The Structure of the TGIF Window

The `Tgif` window has numerous components that provide access to all of TGIF’s features. Before starting the tutorial in Section B.3, you should examine the window and locate its several components, including

- the Titlebar window, which is located across the very top of the `Tgif` window and contains the single word ‘Tgif’.

---

\(^1\)TGIF is copyrighted © by William Chia-Wei Cheng. Full details can be found from the TGIF web site at the URL http://bourbon.usc.edu/tgif/. Use of TGIF at any site, and particularly distribution of TGIF to other sites, is governed by licensing restrictions, the terms of which at your site are explained in the Local Guide. The TGIF icons appearing in this appendix have been copied from screen displays produced by TGIF and are used by permission of William Chai-Wei Cheng.

\(^2\)what you see is what you get.

\(^3\)This man-page is lengthy. You will find examining it easiest if you open it in a separate Shell window so you can then easily scroll both forward and backward as you read the information it contains.
APPENDIX B. INTRODUCTION TO TGIF

- the Top window, which is located just below the Titlebar window and contains the name of the file currently active in TGIF. Initially, the phrase ‘[Unnamed] (100%)’ is likely to be displayed in this window.

- the Menubar window, which is located near the top of the Tgif window and beneath both the Titlebar window and the Top window. It contains nine pull-down menus (File, Edit, Layout, Arrange, Properties, Color, Navigate, Special, and Help) that give access to all the options available in TGIF.

- the Status window, which is located across the very bottom of the Tgif window. The left, middle, and right panels of this window correspond to the left (ML), middle (MM), and right (MR) mouse buttons, respectively. When the cursor is positioned over an icon and, many times, when it is positioned over a menu item, each panel in this window displays the action that will ensue if the corresponding mouse button is pressed. It will also display miscellaneous additional status information.  

- the Canvas window, which occupies by far the largest portion of the Tgif window. This window provides the area in which drawings are assembled. Note the rulers along the top and left edges of the Canvas window and the indicators that move around on these rulers when the cursor is moved in the window. When an object in the drawing is dragged to a new position with the mouse, the extent of the object and the position of its center are marked on both rulers, and these marks can be used as guides in positioning the object. The size of the grid and the specification of English or metric scaling are controlled by options in the Layout menu.

- the Mode menu, which is positioned vertically along the left edge of the Canvas window and gives convenient access to the main drawing tools provided by TGIF.

- the Panel or Choice window, which is located directly below the left-hand portion of the Menubar window. It displays two rows of icons that reflect the current settings of various options in TGIF. These settings can be changed by making new selections from the corresponding menus or, often more conveniently, they can be changed by clicking ML—which cycles the selection forward through the options—or MR—which cycles backwards—on the appropriate icon. Depressing and holding MM over many of the icons will generate a pop-up menu in which the desired option can be selected directly from the available settings.

- the Message window, which is located directly below the right-hand portion of the Menubar window. It displays messages that pertain to TGIF itself and the files opened/created/modified in the default directory. This window displays only two lines, but an internal memory retains additional lines. Clicking MR in this window scrolls the messages towards the top (i.e., to earlier messages), and clicking ML scrolls them towards the bottom.

- the scrollbars, which are located along the bottom and right edges of the Canvas window (but only when the contents of the Canvas window extend beyond its on-screen boundaries). Clicking ML in the vertical/horizontal scrollbar below/to the right of the darker area causes the canvas window to scroll down/right by a small distance; clicking ML above/to the left of the darker region has the opposite effect. One can drag the darker region of the scrollbar up or down/left or right with ML. In all cases, the position and size of the darker area in the scrollbars indicates the position and size of the current viewport in the total drawing.

---

Somewhat at odds with the described general behavior, when the cursor is positioned over any of the items in the Menubar window, the middle panel in the Status window displays the action of all three mouse buttons and the left and right panels are empty.
B.3 A Tutorial Exploration of TGIF

In this section, we orient you to the capabilities of TGIF by drawing your attention to various means to place assorted objects in the Canvas window, thereby constructing a particular drawing. We begin by refining the grid.

1. Place the cursor over the word ‘Layout’ in the Menubar window (noting the information in the three panels of the Status window).

2. While depressing and holding ML, move the cursor down in the Layout menu to highlight the phrase ‘-Grid’ and then release ML. Note that the separation of the tics on both rulers is reduced by a factor of 2. (You can probably guess what selecting ‘+Grid’ would accomplish.)

3. Click ML and/or MR once or twice on one of the rulers, noting that these operations provide an alternative way to contract or expand the scaling on these rulers.

These simple operations have selected one of the options in the Layout menu and have also illustrated one of the ways by which an item from a menu can be invoked: (a) place the cursor over the name of the menu, (b) depress and hold ML, (c) move the cursor down in the resulting pop-up menu to the desired item, and (d) release ML. Alternatively, you might click ML on the name of the menu (which will cause the menu to remain displayed) and then click ML on the desired item (which will select the item and close the menu).\(^5\)

Having chosen a finer grid than the default, we now place a few graphic objects in the Canvas window. To draw a polyline with specified vertices, for example,

4. Move the cursor over the various buttons in the Mode menu along the left edge of the Canvas window, noting the information in the Status window.

5. Position the cursor in the Mode menu to highlight the icon \(\text{ polyline}\), which represents the polyline drawing mode (noting yet again the information in the Status window), and click ML to select that option.

6. Move the cursor to a selected point in the Canvas window (noting once more the information in the three panels of the Status window\(^6\)), and click ML to select the point.

7. Move the cursor to another point, noting the line that joins the position of the cursor to the original point, and click ML. Note also that, with ‘snap to grid’ on by default, you can select only grid points as defined by the rulers.\(^7\)

8. Repeat the previous step half a dozen times.

9. Move the cursor to one more point.

10. Click MR (yes, MR, not ML) to terminate the line. The arrowhead is added automatically at the end of the polyline because of the default configuration of TGIF.

This sequence has illustrated the basic operations for constructing a drawing: (a) select a drawing mode, (b) place an object, (c) select another mode, (d) place another object, ... Each of the available modes is described more fully in Section B.5.1.1.

Since switching from mode to mode is perhaps the most frequent operation as a drawing is constructed, MR has been given a special function when the cursor is in the Canvas window: it allows convenient selection of a new drawing mode. To illustrate this convenience,

---

\(^5\) All of the items in all of the menus can be selected by either of these methods (and also by a method described in Section B.7). A fuller description of the most important of the items available in each menu is included in Section B.5.

\(^6\) At this point, we will stop drawing your attention specifically to the Status window. Do, however, remain alert to its changing contents.

\(^7\) Whether selected points snap to the grid or not is determined by the item ‘Snap to Grid’ in the Layout menu.
11. Place the cursor in the Canvas window.

12. Press and hold MR. A copy of the Mode menu will pop up.

13. Move the cursor in that pop-up menu to highlight the icon \(\Rightarrow\), which represents the select mode, and release MR.

Note that the vertices of the polyline you just drew are now marked with small squares, which we will call handles, and the polyline is now selected. Note also that the icon highlighted in the Mode menu has reverted to the originally highlighted icon, specifically to \(\Rightarrow\).

When TGIF is in select mode, ML can be used to select and deselect objects and to move and reshape selected objects. To explore this feature,

14. Click ML somewhere in the Canvas window but not on the selected object. The object will be deselected.

15. Click ML somewhere on the polyline. The object will be selected again.

16. Depress and hold the ‘shift’ key and then click ML on the selected object. The object will again be deselected.

17. Select the polyline again.

18. Press and hold ML somewhere on the line but not on a handle.

19. Drag the object to a new location (noting the box that appears around it and also the nature of the markers that move around on the rulers).

20. When you have repositioned the object to a desired new location, release ML.

21. Press and hold ML on one of the handles.

22. Drag the vertex to a new location, and release ML.

23. Click ML somewhere in the Canvas window to deselect the object.

These actions illustrate how, in select mode, an object can be selected and deselected, relocated as a whole, and reshaped in detail vertex by vertex.

In the course of using MR to bring up the Mode menu, you may have discovered that the menu (and actually many of the menus) can be pinned. In particular, placing the cursor in the Canvas window and clicking and releasing MR, opens a pop-up Mode menu in which the currently selected mode is highlighted. When this pinned menu is on the screen, (a) clicking any mouse button on an item in the menu selects that item and closes the menu, and (b) clicking any mouse button anywhere in the Canvas window not on the menu closes the menu without changing the selected mode. To explore these behaviors,

24. Bring up the pop-up Mode menu by clicking MR in the Canvas window.

25. Select rounded-corner rectangle mode by clicking MM on the icon \(\square\), noting again the change in the icon highlighted in the Mode menu along the left edge of the Status window.

26. Position the cursor in the Canvas window.

27. Depress and hold ML.

28. While holding ML, move the cursor to a new point some distance from the first point and not along either axis through that first point.
29. Release ML to position the rounded-corner rectangle in the Canvas window.

30. Bring up the pop-up Mode menu again by clicking MR in the Canvas window.

31. Select text mode by clicking MM on the icon T.

32. Position the cursor in the Canvas window.

33. Click ML. A vertical bar in a shaded box appears, marking the point at which text will be inserted.

34. Type some text on the keyboard. The default font (Courier), font size (14 point), and font alignment (left-justified) will be used.\footnote{The font, its size, and its alignment can all be changed by selecting items from the font panel in the Properties menu. As described in Section B.8, the defaults established when TGIF is launched can be changed by creating a suitable file named .Xdefaults in your home directory.}

35. Bring up the pop-up Mode menu yet again by clicking MR in the Canvas window.

36. Select select mode by clicking MM on the icon .\footnote{This button is labeled differently in different implementations of the X-window interface. A common, but by no means universal, label is a − sign.} [By now, you have probably concluded (correctly) that return to select mode from any other mode will leave the most recently placed object selected.]

37. Depress the ‘shift’ key and click ML somewhere on the text you just entered to deselect it.

You now have a jagged line with an arrowhead, a rectangle, and some text in your Canvas window.

Alternatively (and you may have discovered this possibility inadvertently in your explorations to this point), you can pin the Mode menu by (a) placing the cursor in the Canvas window, (b) pressing and holding MR, (c) dragging the cursor to a point a modest distance (more than an inch or two) from the starting point, and (d) waiting a moment before releasing MR. When the Mode menu is placed on the screen in this way, (a) clicking MM on an item selects that item without closing the menu, (b) clicking MR anywhere on the menu closes the menu without changing the selected drawing mode, and (c) pressing and holding ML on the button in the extreme upper-left corner of the menu\footnote{This button is labeled differently in different implementations of the X-window interface. A common, but by no means universal, label is a − sign.} opens a pop-up menu in which you can select ‘Move’ (and then relocate the window) or ‘Close’ or ‘Quit’ to dismiss the window. To explore these behaviors,

38. Bring up and reposition the pop-up Mode menu, make several selections with MM, and then close the menu with MR. Make sure you finish this exercise by leaving the system in select mode ( ).

Paralleling the behavior of the Mode menu when MR is manipulated with the cursor in the Canvas window, MM can be used to pop up the Main menu, facilitating selection of any submenu. As with the action of MR as well, there are several variants of the behavior. Basically, however, after selecting an item from the pop-up Main menu (by clicking ML on the item), you will be able to select the desired item from that menu by clicking ML on it.

The icons in the Panel window reflect the current settings of various options in TGIF. The options beneath each icon can be selected by clicking ML—which cycles the selection forward through the options—or MR—which cycles backwards—on the appropriate icon in the Panel window. Depressing and holding MM over many of the icons will generate a pop-up menu of the available settings, in which you can select a particular setting. Note that, when the cursor is positioned over an icon in the Panel window, the function of each mouse button is displayed in the Status window. To explore some of these features,

39. Make sure select mode ( ) is active
40. Select the polyline created much earlier (by clicking ML on it).

41. In the Panel window, place the cursor over the icon that is a horizontal line with the word ‘solid’ above it (fourth from right in the top row, if the defaults have not been changed), noting the information in the three panels of the Status window.

42. Click ML two or three times on this icon, noting the changes in the icon, in the information in the Status window, and in the polyline in the Canvas window.

43. Click ML several more times on that icon, cycling through the options to return to the original solid line. In all cases, the changes affect both the selected object and the icon immediately.

44. Click MR two or three times on this icon, noting again the changes in the icon, in the information in the Status window, and in the polyline in the Canvas window.

45. Press and hold MM on this icon, slide the cursor down the resulting pop-up menu to highlight an item, and release MM, noting once again the changes in the icon, in the information in the Status window, and in the polyline in the Canvas window.

46. In the Panel window, position the cursor over the icon that is a line with an arrowhead (fourth from right in the lower row of the Panel window).

47. Click ML and/or MR repeatedly on this icon to cycle through the options. Note again the changes in the selected object and in the icon.

48. Click ML and/or MR repeatedly on the icon −1− (bottom row near the right end in the Panel window), noting the change in the polyline with each click and the change in the number in the icon.

49. In the Canvas window, click ML somewhere on the rounded-corner rectangle so as to deselect the polyline and select the rectangle.

50. Move the cursor to the fill-pattern icon (second from right in the top row of the Panel window; by default it shows the word ‘NONE’).

51. Press and hold MM, move the cursor to a fill pattern that attracts your attention, and release MM. The rectangle is now filled with the selected pattern and the default fill pattern is changed.

52. Move the cursor to the color icon (first from the right in the top row of the Panel window).

53. Press and hold MM, move the cursor to a color of your choice, and release MM. Again, the rectangle and its bounding line are now colored and the default color is changed.

54. In the Canvas window, click ML somewhere on the text so as to deselect the rectangle and select the text.

55. Click ML and/or MR once or twice on the object rotation icon (‘abc’) in the Panel window, but be sure to return the text to its original orientation before going on.

B.4 Saving your Drawing

Once you have created a drawing, you will want to save it for subsequent editing and possibly for printing in various ways. In its native operations, TGIF uses its own private object files, which are designated with the file type .obj. TGIF is capable of reading other file types, but only .obj files can be read and then edited. TGIF is also capable of writing other file types but only after the .obj file has been saved. Encapsulated PostScript (.eps) files (file type .eps), raw PostScript files (file type .ps), X11 bitmap files (filetype .xbm), HTML files (file type .html), and PDF files (file type .pdf)
B.5 TGIF OPTIONS AND TOOLS

are among the possibilities. Encapsulated PostScript files and PDF files are primarily utilized for incorporation into a \LaTeX{} document, but they and also a (non-encapsulated) PostScript file can be printed directly with the `print` command (Windows) or the `lp` (UNIX)—or equivalent—command to the operating system. Both the X11 bitmap format and the PostScript formats are recognized by many programs which can be used to convert TGIF’s output to nearly any other graphics format.\footnote{Programs available at your site for this purpose are identified in the Local Guide.}

To write a description of your drawing into a file of an available type, we must first save the drawing in TGIF’s native mode. To do so, we

56. Select ‘Save’ from the File menu.

57. Type a suitable file name in the pop-up text entry box and press the RETURN key. (You do not need to type the file type .obj explicitly; TGIF will supply it.)

The file will be created in the default directory, the new name will be recorded in the Top window right under the Titlebar window, and a message recording the action will appear in the Message window. Since the .obj file is an ASCII file, you can examine it with the command `more` or with your favorite text editor. Be prepared to be bewildered.

Once the .obj file has been created, you can then “print” the display to files in other formats. If, for example, you anticipate sending the resulting file directly to a PostScript printer, either a standard PostScript file or an encapsulated PostScript file will work, though the standard PostScript file would be the conventional choice. To create such a file,

58. Make sure the output file type is PS (or EPS) by using ML and/or MR to cycle the print mode icon (right-most icon in the lower row in the Panel window) to the PS (or EPS) icon.

59. Check or uncheck the option ‘Print/Export in Color’ in the File menu, as appropriate to your file.

60. Select ‘print’ from the File menu, and note the message that appears in the Message window.

A file with the same name as the .obj file but with file type .ps (or .eps) will be created in the default directory; this file can be sent directly to a PostScript printer. Either the standard PostScript file or the encapsulated PostScript file will also work for incorporation in a \LaTeX{} document, though an encapsulated PostScript file would be the conventional choice. Note that both the .ps and .eps files are ASCII files, and can be examined directly with a text editor—though they are likely to be even more bewildering than the .obj file.

B.5 TGIF Options and Tools

In the previous two sections, we have used some of TGIF’s capabilities to create and save a particular drawing, thereby providing a prototype of the process we might use to create any drawing. In what follows, we depart from the tutorial mode adopted thus far and shift to the style of a manual, enumerating and describing capabilities without trying to illustrate their uses in natural contexts.

B.5.1 Menu Options

All features of TGIF—those we have already met and all the rest—are controllable from one or another of the ten main menus (Mode, File, Edit, Layout, Arrange, Properties, Color, Navigate, Special, and Help), all but the first of which can be accessed either directly from
the corresponding label in the **Menubar** window or from one or another of the icons in the **Panel** window. The **Mode** menu is displayed along the left edge of the **Tgif** window but, as we have already illustrated, can also be accessed through use of MR in the **Canvas** window.

**B.5.1.1 Mode Menu**

The **Mode** menu offers several drawing modes. In the enumeration below, the name of each mode is followed by the corresponding icon and a brief description.

- **Select Mode**
  
  In select mode, a first clicking of ML on an object selects the object and subsequent uses of ML move or reshape that object in various ways. When an object is selected, it is highlighted by square **handles** at its corners/vertices. Once an object has been selected, ML has many functions. In particular,
  
  - Dragging one of these handles with ML reshapes the selected object.
  - Dragging some other portion of the selected object with ML relocates the entire object.
  - Depressing ML on a handle of some objects (rectangles, ovals, . . .) and then depressing the ‘shift’ key activates proportional stretching, which adjusts all dimensions in the same proportion.
  - Depressing the ‘shift’ key and then clicking ML on a selected object deselects that object.
  - Clicking ML somewhere other than on the selected object deselects the object; clicking ML on another object both deselects the currently selected object and selects the new one.
  - Holding down the ‘shift’ key and clicking ML on an object that is not currently selected adds the object to the group of selected objects.

- **Text Mode**
  
  Text mode allows for the insertion of text by clicking ML to position a vertical cursor at the point where text is to be located and then typing the text on the keyboard. Once finished, the text string behaves as a single object, and the font, text style, text size, and alignment can all be modified by selecting the string and changing the appropriate attributes (from the **Properties** menu or the **Panel** window). In addition to the available fonts (Times, Courier, Helvetica, New Century Schoolbook, and Symbol), other non-standard ASCII characters can be inserted with an escape sequence. In Text mode, after specifying the point at which text is to be inserted, press (and release) the ‘Esc’ key, then a character on the keyboard to generate one of many different non-standard characters. A key to the available characters and symbols for the Times font is shown in Fig. B.1.

- **Rectangle Mode**
  
  Rectangle mode allows us to create closed rectangles by positioning the cursor at one corner of the desired rectangle, pressing and holding ML, moving the cursor to the diagonally opposite corner of the rectangle, and releasing ML. Holding down the ‘shift’ key while making a rectangle will create a square. Rectangles and all other closed objects (ovals, polygons, and rounded-corner rectangles) will automatically be filled with the currently selected fill pattern (which, by default, is no fill at all).

- **Corner Oval Mode**
  
  Corner oval mode allows us to create ovals by positioning the cursor at one corner of the rectangle circumscribing the desired oval, pressing and holding ML, moving the cursor to the diagonally opposite corner of that rectangle, and releasing ML. Holding down the ‘shift’ key while making an oval will result in the creation of a circle. The created oval will automatically be filled with the currently selected fill pattern.
Figure B.1: Key to some of the non-standard ASCII characters available with ‘Esc’ sequences. In each triplet of lines, the middle line identifies the key to press, the top line reveals the character produced when pressing the key in the middle line occurs while \( \langle \text{ESC} \rangle \) and \( \langle \text{SHIFT} \rangle \) are held down, and the bottom line reveals the character produced when pressing the key in the middle line while \( \langle \text{ESC} \rangle \) \( \text{alone} \) is held down. **Important note:** \( \langle \text{ESC} \rangle \langle \text{SHIFT} \rangle \) or \( \langle \text{ESC} \rangle \) must be released and again held down for a second special character to be produced.

**Times font**

\[
\begin{align*}
\text{<esc>} + \text{shift} + & \quad \text{ÀÈÝØP} | a' \, \odot \, \beta \, \langle \\
\text{this key} & \quad 1 \ 2 \ 3 \ 4 \ 5 \ 6 \ 7 \ 8 \ 9 \ 0 \ = \\
\text{<esc>} + & \quad \tilde{\alpha} \ \tilde{z} \ \tilde{\mu} \ \tilde{\gamma} \\
\text{<esc>} + \text{shift} + & \quad \text{Ñ×ÅÒÔÙÕÉÍĐûýü} \\
\text{this key} & \quad \text{qweṛtyuiop[ ]} \\
\text{<esc>} + & \quad \tilde{n} \ \tilde{a} \ \tilde{o} \ \tilde{ò} \ \tilde{ò} \ \tilde{ô} \ \tilde{ê} \ \text{iðÚÝÜ} \\
\text{<esc>} + \text{shift} + & \quad \text{ÁÓÄÆÇÈÊÉÌ°ç} \\
\text{this key} & \quad \text{asdfsghijkl;} \\
\text{<esc>} + & \quad \tilde{á} \ \tilde{ó} \ \tilde{â} \ \tilde{æ} \ \text{çêêëî} \ \text{§} \\
\text{<esc>} + \text{shift} + & \quad \text{ÚØÃÖÂÎÍ} \ \text{¿} \\
\text{this key} & \quad \text{zxcsvbmn, . /} \\
\text{<esc>} + & \quad \text{úøãöââîí®} 
\end{align*}
\]

- **Center Oval Mode**
  Center oval mode allows us to create ovals by positioning the cursor at the center of the desired oval, pressing and holding ML, moving the cursor to a corner of the circumscribing rectangle, and releasing ML. Holding down the ‘shift’ key while making an oval will result in the creation of a circle. The created oval will automatically be filled with the currently selected fill pattern.

- **Edge Circle Mode**
  Edge circle mode allows us to create circles by positioning the cursor at a point on the circumference of the desired circle, pressing and holding ML, moving the cursor to a point at the other end of a diameter of the desired circle, and releasing ML. The created circle will automatically be filled with the currently selected fill pattern.

- **Polyline (open-spline) Mode**
  Polyline mode allows us to create polylines by placing nodes at points identified by clicks of ML. To identify the last point on the line, click MR instead of ML. Whether the created object is a succession of straight line segments, an open/closed spline curve, or an interpolated spline curve is determined by the current specification of an item from the ‘Line’ panel of the Properties menu. That setting is indicated by an icon in the Panel window and can, alternatively, be changed by mouse clicks on that icon. The created object will automatically be filled with the currently selected fill pattern, in which operation the object will be imagined closed by an invisible line joining the first to the last point.
• **Polygon (closed-spline) Mode**

Polygon mode allows us to create closed polygons with vertices at points identified by clicks of ML. To complete the shape, place a final vertex (click ML) very near to the starting point. Whether the created polygon is bounded by a succession of straight line segments, an open/closed spline curve, or an interpolated spline curve is determined by the current specification of an item from the Line Type (sub)menu of the Properties menu. The created object will automatically be filled with the currently selected fill pattern.

• **Arc Mode (center first)**

Arc mode (center first) allows us to create an arc of a circle by specifying the center of the arc and then its endpoints. To create that arc, click ML first at the desired center of the circle and then at the starting point of the arc. (The separation of the first two identified points defines the radius of the arc.) Finally, move the cursor to trace out the arc. Click ML—yes, ML (not MR)—to finish the arc. The created arc will automatically be filled with the currently selected fill pattern, in which operation the object will be imagined closed by invisible lines joining the center of the arc to its two ends.

• **Arc Mode (endpoints first)**

Arc mode (endpoints first) allows us to create an arc of a circle by specifying its two endpoints first. To create that arc, click ML at the first endpoint and then at the second endpoint of the desired arc. Finally, move the cursor to select the desired radius and click ML—yes, ML (not MR)—to finish the arc. The created arc will automatically be filled with the currently selected fill pattern, in which operation the object will be imagined closed by invisible lines joining the center of the arc to its two ends.

• **Rounded-corner Rectangle Mode**

Rounded-corner rectangle mode allows us to create rounded-corner rectangles by positioning the cursor at one corner of the desired rectangle, pressing and holding ML, moving the cursor to the diagonally opposite corner of the rectangle, and releasing ML. The radius of curvature of the rounded corners can be adjusted in the Panel window. The created object will automatically be filled with the currently selected fill pattern.

• **Freehand Mode**

Freehand mode allows us to create curves that follow the mouse for as long as ML is held down. The curve terminates when ML is released. TGIF automatically inserts as many nodes along the curve as necessary.

• **Select Vertices Mode**

In select vertices mode, ML selects and moves vertices of polylines and polygons. In this mode, all eligible objects will have their vertices highlighted with squares. When a vertex is selected (by clicking ML on one of the vertex-squares), it becomes highlighted with a ‘+’ sign. Operations available to these doubly highlighted vertices are move, delete, align (with each other), distribute (space them equally), and align to grid. The arrow keys can also be used to move selected vertices.

• **Rotate/Shear Mode**

Rotate/shear mode allows selected objects to be rotated and/or sheared (twisted) by using ML to grab one or another of the handles on the object and dragging it to a new location. Grabbing a *corner* handle will allow rotation; grabbing a handle in the middle of a side will allow shearing.
B.5. TGIF OPTIONS AND TOOLS

B.5.1.2 File Menu

The File menu offers functions that deal with access to files stored on disk. The more commonly used functions are

- **New** – opens a new, blank Canvas Window.
- **Open** – brings up a pop-up window in which we can select an existing .obj file for TGIF to open. The default directory is the one from which TGIF was run, but any other path can be specified either by deleting the current path (with the backspace key) and specifying a new path, or by navigating through the file system with the mouse. (Double clicking on the symbol ‘../’ moves up one directory.)
- **Import** – imports files of many types (e.g., object .obj, symbol .sym, ...) into the current drawing. The directories $TGIFHEAD$ and $TGIFHEAD/spice$ contain some sample object and symbol files. In particular the spice subdirectory contains a collection of common electronic elements, many of which (resistors, capacitors, flip-flops, ...) are illustrated in Fig. B.2. Working with object and symbol files can be tricky and removing undesired components may require a bit of creative exploration with the features illustrated in the following two examples.

To import a file of type .sym,

- Select ‘Import’ from the File menu.
- Select ‘Import...’ from the pop-up menu that appears.
- In the resulting browser, locate and click ML on the desired file, e.g., $TGIFHEAD/spice/SN.sym$.
- Click ML on ‘OK’. The symbol will appear in the Canvas window, selected and bounded by a dashed box (which indicates the entity is a symbol). It will also be of several colors and probably illegible.
- With the object selected,
  * Select ‘UnMake Symbolic’ from the Special menu. The dashed box will disappear.
  * Select ‘Ungroup’ from the Arrange menu. (Since a symbol may be constructed of groups of groups, gaining access to every individual component in the symbol may require more than one invocation of ‘Ungroup’.)
  * Select a more appropriate color, e.g., black, for the symbol and its accompanying text from the Color menu.

The symbol can now be treated as any other TGIF construct (resized, relocated, ...) and the associated text can be edited or deleted as any other text.

To import a file of type .obj,

- Select ‘Import’ from the File menu.
- Select ‘Import...’ from the pop-up menu that appears.
- In the resulting browser, locate and click ML on the desired file, e.g., $TGIFHEAD/an-sr-flip-flop.obj$ or $TGIFHEAD/tgificon.obj$.
- Click ML on ‘OK’. The object will appear in the Canvas window, selected but not bounded by a dashed box. It will also be of several colors and probably illegible.
- With the object selected,
  * Select a more appropriate color, e.g., black, for the object from the Color menu.

---

11Remember that the symbol $TGIFHEAD$ must be translated into the appropriate path as described in the Local Guide.
12The files in the spice subdirectory are not included in the TGIF distribution. These files are available at Lawrence because Lawrence has acquired the SPICE software, information about which is available from the URL bwrcs.eecs.berkeley.edu/Classes/ICBook/SPICE/. These files are not included in the program and data files distributed with CPSUP.
APPENDIX B. INTRODUCTION TO TGIF

Figure B.2: Symbol and object files in the $TGIFHEAD/spice directory.

* Many objects will be accompanied by an explanatory text. Read this text, then select it and either move it to an out of the way location or delete it altogether from the display.\(^\text{13}\)
* Select the object itself, not including the text.
* Select ‘Ungroup’ from the ARRANGE menu, and click ML on ‘Yes’ to respond to the ominous question that appears in a pop-up text box.
* Select ‘Hide Attributes’ from the ATTRIBUTES (sub)menu in the SPECIAL menu to remove the illegible colorings from the display.
* If you wish to gain access to each individual component in the resulting structure, you may need to invoke ‘Ungroup’ one or more additional times.

- Save – saves the current drawing in TGIF’s private format, prompting for a name if none was previously given. The extension .obj will be appended to the specified name. This file is the only file that can be read into TGIF to produce an editable display. Further, this file must be present before files in other formats—see ‘print’ below—can be generated.
- Print – creates a file of the type indicated in the Panel window (see Section B.4 and Section

\(^{13}\)The message can be retrieved by selecting the object and then typing ⟨CONTROL-V⟩.
B.5. TGIF OPTIONS AND TOOLS

B.5.2). The created file will have the same filename as the current drawing, but its extension will be that appropriate to the file type. All objects and pages in the Canvas window will be printed, and the dimensions of the drawing in the file will be those of the smallest possible bounding box.

- Print/Export Format – brings up the menu in which you can select to file type (.ps, .eps, .html, .pdf, . . . to be created when the display is printed to a file.

- Print/Export in Color – toggles between printing files that contain the colors in the display on the screen and printing files in black and white. This item functions as a switch that controls what happens when ‘Print’ is selected; it does not actually print anything. In the File menu, this item will either be checked or unchecked.

- Print Selected Objects – creates a file of the type indicated in the Panel window, printing only the selected objects to the file. The created file will have the same filename as the current drawing, but its extension will be that appropriate to the file type. The progress and name of the file created are reported in the Message window. The dimensions of the drawing in the file will be those of the smallest possible bounding box.

- Print One Page – creates a file of the type indicated in the Panel window, printing only the current page (including blank space) to the file. The created file will have the same filename as the current drawing, but its extension will be that appropriate to the file type. A progress report and the name of the file created are reported in the Message window.

- Quit – Quits TGIF.

B.5.1.3 Edit Menu

The Edit menu offers a variety of functions for manipulating objects in the Canvas Window, including

- Duplicate – duplicates the selected object. The duplicated object will be placed in the display slightly displaced from the original and automatically selected, so it can then easily be moved to the desired location.

- Delete – deletes the selected object (appears to be synonym for ‘Cut’).

- Select All – selects all existing objects.

- Undo – undoes the previous action, with levels of undoing.

- Redo – redoes what’s been undone.

- Copy – copies selected objects to a clipboard (for subsequent pasting).

- Cut – moves selected objects to a clipboard (for subsequent pasting).

- Paste – pastes copied, cut, or deleted objects into the current drawing. After selecting ‘paste’, we position the pasted object by clicking ML at the desired point in the Canvas window.

- Shape – offers a submenu of shapes that can be created. After selecting the desired shape from the submenu, move the cursor to the desired point in the Canvas window, depress (and hold) ML, move the cursor to create the shape, and release ML. This action happens only once with each selection of a shape, and creation of the shape automatically sets text mode and places the text cursor in the created shape.

- Properties – offers a submenu in which you can select many of the properties for the selected component of your display. The options are much the same as those in the stand-alone Properties menu.
B.5.1.4 Layout Menu

The Layout menu offers options affecting the settings of the program and how it presents itself to us, including

- +Grid – increases the size of the ruler (and grid) divisions.
- –Grid – decreases the size of the ruler (and grid) divisions.
- Visible Grid (checked or unchecked) – controls whether the grid—a pattern of dots in the Canvas window—is displayed or hidden.
- Snap to Grid (checked or unchecked) – controls whether points selected in the Canvas window are positioned where selected or placed at the nearest grid point as defined by the horizontal and vertical rulers.
- Zoom – opens a submenu offering several options for zooming in or out on the center of the drawing as a whole (or of a selected object).
- Portrait; Landscape – selects the indicated orientation of the display
- Stacked Page – opens a submenu of functions for selecting particular pages of a multipage display, deleting or adding pages, etc.
- Page Layout – opens a submenu of functions to specify whether the pages of a multipage display are shown stacked or tiled.
- Print/Export in Color (checked or unchecked) – parallels the item by the same name in the File menu.
- Metric Grid (checked or unchecked) – toggles between a grid marked with metric units and one marked with English units.
- One Motion Select Move (checked or unchecked) – toggles between two modes for selecting and moving objects. When checked, this option sets TGIF so that one can simply grab and move an object with one mouse-stroke; when unchecked, this option sets TGIF so that an object must be explicitly selected before it can be dragged with ML to a new location.

B.5.1.5 Arrange Menu

Similar to the functions in the Edit menu, the functions in the Arrange menu focus on the arrangement or location of objects in the Canvas Window. Available functions include

- Front – brings a selected object to the front if it happens to be behind one or more objects.
- Back – sends a selected object to the back if it happens to be in front of one or more objects.
- Group – groups multiple objects together for ease of positioning. Grouped objects behave as a single object insofar as selection and relocation are concerned.
- Ungroup – ungroups grouped objects.
- Lock – locks selected objects to the grid.
- Unlock – unlocks locked objects.
- Horizontal Align – opens a submenu allowing specification of horizontal alignment. The options include none, left, center, and right.
• Vertical Align – opens a submenu allowing specification of vertical alignment. The options include none, top, middle, and bottom.

• Flip/Rotate – opens a submenu giving you the options to
  – Flip Horizontal – reflects objects in a vertical line.
  – Flip Vertical – reflects objects in a horizontal line.
  – Rotate Clock-Wise – rotates objects clockwise about an axis perpendicular to the diagram and through the “center” of the object.
  – Rotate Counter – rotates objects counterclockwise about an axis perpendicular to the diagram and through the “center” of the object.
  – Set Text Rotation – allows us to specify the angle by which text is rotated when its typing is terminated by selecting the next object. Angles are specified in degrees, positive values effect clockwise rotation, and the default is $0^\circ$. This parameter affects only text and is independent of the parameter Set Rotation Increment.
  – Set Rotation Increment – allows us to specify the angle by which objects (including text) are rotated with each click of ML on Rotate Clock-Wise or Rotate Counter. Angles are specified in degrees, and the default is $45^\circ$.

B.5.1.6 Properties Menu

The Properties menu combines features, most of which in earlier versions of TGIF were divided among the View, Text, and Graphics menus. It has eight separate panels, which are delineated by horizontal lines. We mention here only a few of the numerous items available in this menu.

Line Width/Font Size Panel

The second delineated panel in this menu offers the opportunity of setting line width and font size arbitrarily, in particular going beyond the quantized options available with mouse clicks in the Panel window. When selected, the option ‘Set Selected Line Width’ gives you the option of specifying the width of a selected line and (optionally) the width and height of the arrow(s) to be drawn at the end(s) of the line; one number or three numbers, separated by spaces, will specify the desired values. When selected, the option ‘Set Selected Font Size’ offers the option of specifying—presumably in points—the size of the font you wish to be used for the text that is selected in the Canvas window.

Font Panel

The Font panel gives us control over the attributes of text in TGIF and offers the options

• Font – changes the font of selected text. The available\textsuperscript{14} fonts are Times, Courier, Helvetica, New Century Schoolbook, and Symbol.

• Text Style – changes the text style of selected text to Roman, Bold, Italic, or BoldItalic; Left, Center, or Right justified; and No Underlined or Underlined.

• Text Size – changes the size of selected text (8, 10, 11, 12, 14, 17, 18, 20, 24, 25, or 34—all in points—are the default allowable sizes). Note, however, the discussion of the Line Width/Font Size panel.

Line Panel

The Line panel contains four items, each of which provides a link to a submenu offering several choices for the associated characteristic of the lines to be drawn. The items are

\textsuperscript{14}The included possibilities can be changed by appropriate entries in the user’s .Xdefaults file, as described in Section B.8.
APPENDIX B. INTRODUCTION TO TGIF

- Line Dash – offers a submenu of patterns for producing dashed lines on selected objects (not including text). Several patterns from solid to dotted are available.

- Line Style – offers a submenu of line styles (no arrows on the line, arrow at beginning of line, arrow at end of line, arrow at both ends of line) to be used on selected objects (not including text). The arrow is placed only at the end of a polyline, not at each vertex. Arrows can also be placed on arcs and other curves.

- Line Type – offers a submenu of line types [straight segment, open/closed spline (curve fit), interpolated (curve fit through points)] to be used in connecting vertices for polylines.

- Line Width – offers a submenu of line widths to be used in the drawing of objects (not including text).

Most of these options are also available with mouse clicks on various icons in the Panel window.

Fill/Pen Panel

The Fill/Pen panel offers the two options

- Fill – offers a submenu of patterns to be used in the filling of selected (closed or open) objects. An open object will be filled as if a straight line connected the beginning point to the ending point.

- Pen – offers a submenu of patterns to be used in drawing the lines defining an object. If ‘pen’ is set to none (with a white fill), the resulting object will be invisible but will cover portions of another object underneath it. In many cases, the same end result can be accomplished with the filling of open objects. Note that the nature of the pattern will not be particularly evident unless fairly wide lines are drawn.

B.5.1.7 Color Menu

The COLOR menu allows us to change the color of selected objects. Both the lines bordering the object and any fill patterns will be changed to use the selected color.

B.5.1.8 Navigate Menu

The Navigate menu provides functions to facilitate navigating among several files that might be simultaneously invoked in a single session. Capabilities to return to the previous file, move forward to the next file, reload (refresh) the current file, and select a file from the current history list are among the available functions.

B.5.1.9 Special Menu

The Special menu contains a large assortment of miscellaneous functions for manipulating attributes of an object, making and “unmaking” symbolic objects, .... Fuller descriptions of these features will be found in the TGIF man-page.

B.5.1.10 Help Menu

The Help menu gives access only to information about the version of TGIF you are using. It does not provide a link to any useful help messages. For that information, we must examine the TGIF man-page.
B.5.2 Panel Icon Options

The Panel window gives convenient access to many of the options available in the menus of TGIF. The Status Window displays the function of the icon over which the mouse is positioned. As we have already illustrated, clicking ML on an icon will scroll through the list in one direction, while clicking MR will cycle through the options in the other direction. Clicking MM on many of the icons will generate a pop-up menu of all the possible choices of that particular option. There are two rows of icons in this window. The two rows and the settings conveyed by each icon are shown in Fig. B.3.

B.6 Utilizing \LaTeX{} to Enter Equations in TGIF

TGIF is capable of utilizing the \LaTeX{} formatting language via the \LaTeX{} Equation Package,\footnote{The \LaTeX{} Equation Package is included in the TGIF package that can be downloaded from Tyg’\textquotesingle{}s WWW Home Page, bourbon.usc.edu/tgif/.} consisting of a symbolic file named\footnote{The proper file to use depends on whether your system uses ps2epsi or pstoepsi for the conversions TGIF needs to do. Use eq4.sym if pstoepsi is available, eq4-ps2epsi.sym if ps2epsi is available. To test for the availability of these programs in your environment, execute the command which ps2epsi and/or the command which pstoepsi. At Lawrence, ps2epsi is the available program.} eq4.sym or eq4-ps2epsi.sym and a \LaTeX{} file named simple.tex. The first step in entering an equation defined by \LaTeX{} commands into a TGIF document is to import the appropriate ‘.sym’ file into the TGIF document by

1. Typing the key command ‘Alt-p’ or selecting ‘Import’ from the Import (sub)menu of the File menu to bring up a file browser.
2. Editing the directory in the text box at the top of the browser so that it points to the directory $\$TGIFHEAD$ and double-clicking ML on eq4-ps2epsi.sym (or, if appropriate in your environment, to $\$TGIFHEAD/eq4.sym$).

Selecting this file places in the Canvas window (1) a symbolic unit (portrayed by a dashed box), (2) a (red) text message (that provides instructions), and (3) a blue text string, which begins with and is named by the characters ‘eq =’. Item (3) is attached as an attribute to the symbolic object. The structure of items (1) and (3) is shown in Fig. B.4. In addition, but not shown in Fig. B.4, the structure is accompanied by instructions for the use of the symbol.

The blue text is referred to as a regular attribute. It contains the \LaTeX{} commands defining the specific equation to be entered into the TGIF document. The default visible text,

\begin{verbatim}
\textasciitilde eq=
\Large
\| E=\textasciitilde M\textasciitilde C^2
\|\n\end{verbatim}

(see Fig. B.4) will produce the equation

\[ E = MC^2 \]

in \LaTeX{}.

Other text associated with the symbolic unit is referred to as a file attribute, but it is invisible because it is not to be edited. The file attribute contains the information necessary for TGIF to invoke \LaTeX{} and create the PostScript file containing the \LaTeX{} text.

Once the file eq4-ps2epsi.sym (or eq4.sym) has been imported into the TGIF document, creation of the desired equation involves the following steps:
3. Select text mode.

4. Using text mode, edit the contents of the regular attribute (blue text) to define the desired \LaTeX text. Note in particular the following:
   - The flagging label "\texttt{eq =}" tells TGIF what to do with the specified \LaTeX code; do not remove this label.
   - The desired size of an equation in the final document may require use of the \texttt{\LARGE}, \texttt{\Huge}, and even \texttt{\Huge} commands.

5. Generate the PostScript file which will appear in the final PostScript version of the document by
Figure B.4: Symbolic unit created when inputting the file eq4-ps2epsi.sym (or eq4.sym). The text attribute is here shown in black, but it will be blue in the Canvas window.

\[ \text{eq}4 \equiv \LaTeX \left\{ \begin{array}{c} \{ \text{E} \}; \equiv \ln, M^2, C^2 \\ \{ \end{array} \right. \]

- Selecting select mode.
- Selecting the symbolic unit.
- Double-clicking ML on the selected symbolic unit (or, with the cursor in the symbolic unit, holding down the ‘shift’ key and then depressing the middle mouse button and then releasing both).

In response, TGIF will (1) spawn a new shell window in which \LaTeX will process the commands specified in the regular attribute; (2) invoke \texttt{dvips} to convert the .dvi file to a PostScript file; and (3) spawn a third shell window in which \texttt{ps2epsi} will convert the PostScript file to an encapsulated PostScript file allowing adjustment of the bounding box containing the PostScript figure.\footnote{The commands that TGIF will pass on to the operating system will fail unless the operating system knows how to find the associated files. In particular, environment variables and/or the search path in the shell window from which TGIF was launched must be set so that \texttt{latex}, \texttt{dvips}, and \texttt{ps2epsi} will execute properly when called from the operating system’s prompt in that window.} Finally, TGIF will display a bitmap version of the PostScript image for positioning on the Canvas window. Although the bitmap version may not have the resolution of the PostScript image (and in particular the equal sign may not appear on the screen correctly), rest assured that the higher quality PostScript image will be present when the TGIF document is printed.

Once the equation is produced on the canvas in satisfactory form, the regular attribute no longer need be shown. Fortunately, the attribute can be hidden by

6. Selecting the symbolic object and

7. Selecting ‘Hide Attributes’ from the Attributes (sub)menu of the Special menu.

The equation also no longer needs to be considered as a separate unit from the rest of the material in the Canvas window, so we can remove its status as a symbolic unit by

8. Selecting it and

9. Selecting ‘UnMake Symbolic’ from the Special menu. (Since TGIF may save only files that have no more than a single symbolic unit, it is advisable to remove the symbolic status of each equation generated.)

You may also wish to select and delete the instructional text that was displayed when you first imported the file.
At this point, the \LaTeX{} equation has become the same as any other object in TGIF in that it may be translated, stretched, rotated, or flipped. Unfortunately, any changes to the color of the equation made in TGIF will not appear in the printed version. See Leslie Lamport’s \LaTeX{} User’s Guide and Reference Manual\footnote{Leslie Lamport. \LaTeX{}: A Document Preparation System User’s Guide and Reference Manual (Reading, Massachusetts, Addison-Wesley Publishing Company, 1994).} for information about the color package and Section B.7.2 of this appendix for information about color in TGIF.

### B.7 Miscellaneous Additional Features

#### B.7.1 Keyboard Sequences

Nearly all commands in TGIF can be activated with an appropriate keystroke. Like most windowing systems, tasks tend to be easier to learn with a mouse, and faster to invoke once the keyboard shortcut is known. Table B.1 shows some of the more useful keystrokes.

In addition, the arrow keys can be used to move selected objects by one grid increment for each pushing of a key. Further, if no objects are selected, the arrow keys will scroll the drawing area by a small amount, and the arrow keys in combination with the ‘Control’ key will scroll the drawing area by a full screen.

#### B.7.2 Creating Color PostScript Files

If you have used color in your display and you wish that color to be reproduced in PostScript files written by TGIF, you must make sure that the item ‘Print/Export in Color’ in the File menu or, equivalently, the item by the same name in the Layout menu is checked. Otherwise, TGIF will produce a black and white or grey-scale rendition in PostScript, regardless of whether you have used other colors in constructing the display.

#### B.8 Default Values and Customizations

TGIF admits many different settings and customizations. Default values of these aspects are set by the program, but individual users can change these defaults (attributes, foreground and background colors, . . .) by placing appropriate lines in a file named .Xdefaults residing in the user’s home directory.\footnote{This particular file (.Xdefaults) is standard to the X Window system. Customizations for many different programs including TGIF, XEMACS, and others can be specified here as well.} In the absence of this file, tgif sets the defaults internally. The sample file $\$TGIFHEAD/tgif.Xdefaults in the TGIF program directory illustrates many of the possibilities. When a file named .Xdefaults is placed in the user’s home directory, defaults specified in it will override the internal settings of the program for that user. A few of the defaults you might wish to change are listed in Table B.2. The listed items have the functions
Table B.2: Some of the parameters that can be specified in the file `.Xdefaults`. The man page on TGIF contains a complete listing of the possible changes to this file along with a full description of the function of each.

Figure B.5: Diagram for Exercise B.1.

- **Tgif.Geometry** specifies the size (height $\times$ width) and placement (from the upper right corner, in pixels) of the TGIF window.
- **Tgif.Foreground** specifies the foreground color of TGIF.
- **Tgif.Background** specifies the background color of TGIF.
- **Tgif.BorderColor** specifies the border color of TGIF.
- **Tgif.ShortCuts** specifies user-defined shortcuts. In the example in Table B.2, the created shortcut assigns the ‘quit’ function to the ‘q’ key on the keyboard. See the TGIF man-page for a listing of functions and syntax issues.
- **Tgif.FontSizes** specifies the type sizes that appear in the FontSize pop-up menu.
- **Tgif.OneMotionSelMove** specifies that the ‘select and move in one motion’ option is set by default (as opposed to the ‘click once to select, then move’ option).

### B.9 Exercises

**B.1.** Using TGIF, create a file containing the diagram in Fig. B.5. Note that the symbols (but not their subscripts) are all italic and that the subscripts are smaller than the symbols to which they are attached. In creating the diagram, do not draw more than one resistor laboriously; use the capabilities available through the options ‘Rotate Clock-Wise’, ‘Rotate Counter’, and ‘Set Rotation Increment’ in the *Flip/Rotate* panel of the ARRANGE menu and the ‘Copy’ and ‘Paste’ options in the *Edit* menu. Further, you will probably have an easier time of moving a letter with an attached subscript if you group the letter and its subscript into a single object with the ‘Group’ option in the ARRANGE menu. Output the diagram to an `.obj` file and to a `.ps` file and send the latter to the printer to obtain a copy to submit with your solution. **Optional:** Output the diagram to an `.eps` or `.pdf` file and then use \LaTeX{} to create a printed copy of the diagram with some added textual description.
Figure B.6: Diagram for Exercise B.2.

B.2. Using TGIF, create a file containing the diagram in Fig. B.6. Note that the letters in the diagram are all italic and pay attention to shading and line weights. You may also find the selections ‘Rotate Clock-Wise’, ‘Rotate Counter’, and ‘Set Rotation Increment’ in the Flip/Rotate panel of the ARRANGE menu to be useful. Output the diagram to an .obj file and to a .ps file and send the latter to the printer to obtain a copy to submit with your solution. Optional: Output the diagram to an .eps or .pdf file and then use \LaTeX to create a printed copy of the diagram with some added textual description.

Figure B.7: Diagram for Exercise B.3.

B.3. Using TGIF, create a file containing the diagram in Fig. B.7. The capabilities provided by the options ‘Front’ and ‘Back’ in the ARRANGE menu may be useful. Output the diagram to an .obj file and to a .ps file and send the latter to the printer to obtain a copy to submit with your solution. Optional: Output the diagram to an .eps or .pdf file and then use \LaTeX to create a printed copy of the diagram with some added textual description.
Index

Symbols

$\text{TGIFHEAD}$, 11

L

Local Guide, 1, 7, 11

T

TGIF, 1–22
TGIF Arrange menu, 14–15
TGIF Canvas window, 2, 3
TGIF Color menu, 16
TGIF contact information, iii
TGIF Edit menu, 13
TGIF File menu, 11–13
TGIF Help menu, 16
TGIF Layout menu, 3, 14
TGIF Menubar window, 2–3
TGIF menus, 7–17
TGIF Message window, 2, 13
TGIF Mode menu, 2, 8–10
TGIF Navigate menu, 16

TGIF Panel window, 2, 5–6, 17
TGIF pop-up menus, 4–5
TGIF Properties menu, 15–16
TGIF select mode, 4
TGIF Special menu, 16
TGIF Status window, 2, 3, 17
TGIF Titlebar window, 1
TGIF Top window, 1
TGIF tutorial, 3–6
TGIF windows, 1–2

U

UNIX commands

lp, 7

tgif, 1

W

Windows commands

print, 7

writing data to files

in TGIF, 6–7, 12–13